Annexure-|V
- Syllabus
For ,
Integrated Masters’ Degree in Commerce
(IMDC)
AT Under
A UNI NEP-2020

7 (For First two Semesters)

Department of Commerce
Tripura University
S, K- Sen (A Central University)
e 2023

Ii



Y o8
satty M ¢ T
A %
§OdHE .
seiudiey.,
SANINOGT) PApPY anjna IIVA
SASANO0D) AR udWDUBIU] HIgy 90 C
SISIN0)) Ju3WDdUERYUY [[MYS DO AS
sasano)) Areuijdidsipaojug <61
., S2AB291Y dyadg dutpdosiq HSa
$3sano)) 10D ayadg sundidsi(g DS
:3JON
_ o D2 i
g oy W_w:“_mowﬁ DTOTANOD | DT0TNINOD
i i P 10§ spuatipeda JEOTININOD ey __ _ Iv] ”
h_ “,.,w m ML. __uw ’ DOOW /A jeanoe1d) DYIO WOt Hwﬁwﬂhw_ E i e 3|
_ et eagspeasds Susn | DOOW A0 | goyougng | MW | Bupunosoy
E_ e Sununoooy [eioueury | ~UON 104) Sununosoy OIDII IR N paouRApY :
o) i __ JO s[euREpUn § : _“
SQIWLO]) Ui J1eDY IR 1~3¥A -)odv _-umm A0 1ININOD DTOIANOD DI0TIAIWOD
Iz L] <} [t] [v] [v] :
sjpralgas ey toad UOLIBDTUTILILLIO ) {{eonae1) suoyeonddy SAUBUIALIBIN Euﬁummﬁmz m.:ﬁcmcuuﬁ.
HELHLEG Ty D) WG ssauisng ndwoe)) jo sotseq ssauisng sTUtsng [B1OURBUL
] Jsensus Ui} B)IISS) [
[uoyeanq wnuxep| | Aaasng/yaalorg A_ | ) .._u ; 'd (3107)) fode
| | / | $3SIN0") [BUOIIEI0 A §35IN0°) | 2AdIY | o o
(3uamaainbaa yipaan) |/sasanor) peppyv | sasanol) dyradg awmdsyg  lwag| u
; . _ | JuAwWRUeyuy | sdigswadguy/sasanod | Kaeundidsipaajup | [eaausn Lourpy ; e _
[ ], uvonedyijend) INJEA UOWIWO) | sole
Apjiqy JusudUEBYUF [[S

[1ea X 3sa1 d04] 0Z0Z-dAN HAd SV ALISHAAINA VINJdIL

el

A
...Ni}._hﬁ l{
:_._-_- %

Al ..,.:...w
.- ..1.."“.”.-_1

- 7{22085) 1By WJ

m.wnthrn L 10 WQ ;....,wf ¥
o ¥ SN
ﬂvf%ﬁkﬁgﬁf %




[ ]

231 &
7 AH\N,L‘W RN
((u\w " ¥y T ﬂ
dysaonuaaddyy
b 1T [BO110R1 ] /AIOdY ] 20 Z-I)AA /duluel | [erasnpug
_ _. .Buzmﬁm@am |
0 [eanoel | €0 Z-0HS guisn 3ununNoXdY [e12UBLIL]
DI3UWO) _

¢ A102y 001 €0 [-D] -{ION] 10J Bununoddy

¥ K103y ] 001  +0 Z-ASd ~ Solwouods0IN|  AL0TANOD

w K103y ] 001  ¥0 p-008d JuswdaBeuRiN SUllNEINl  DZOZINIWOD

% ALo3y L 001] %0 ¢-00sd AouBlUNO2DY padueAPY|  DIOTNINOD

HIIAA 13 ] SHABJA] 1adey
SISSE])) LRITRLS R \..Caugr: [e101 S}PAL) Jo 3dAT, 1adeg sul Jo SWTN] Ipo)) Jadey
" 19)S9IY PUOIIY
(DFA) swalgns
v /T [ed11oeld xbomfj_ <0 [-DdA | jo jood uowwion) ay) woiy
¢ K103y 001 €0 [-DD4Y | uonesmunwwon) ssauisng
| suonesijddy

9 [E2110E1{ 001 ¢0 [ =DHS 1nduio)) jo soiseq

b Aloay ] 001 y0 [-4Sd SOLRWRYJRN Ssaulsng HE0 LINNOD)

¥ K109y | 001 70 008 JUSWFRUBIA Ssaulsng DZOITNINOD

b Aloay . 001, 0 1-2D08sd BUNUNODIY [RIDUBUL ] D0 TININOD,

Moo 124 : SHABIAI 1de g :

SISSE])) [Bo1}ORBIJ /A0 rr _ch S}IPAIL) Jo 2dA1. 13deq a1y jo uEwl apo)) Jadey

12)SaUISS )SI1]

HANDLINHLS ASY /10

<




Detailed Svliabus for First & Second Semesters
First Semester
DSCC-1 (Major)
Financial Accounting (COMM101C)

Conceptual Framework: Nature of Accounting, Functions, advantages and limitations of
accounting, Users of accounting information and Qualitative characteristics of accounting
information, Accounting as a language of Business, Basic Accounting Equation, Accounting
Cycle, Meaning of Accounting terminologies, Branches of Accounting, Bases of accounting: cash
basis and accrual basis, Basic Accounting Concepts and Conventions, Revenue Recognition,
Reserves and Provisions, GAAPs, introduction to Accounting Standards (AS), Ind AS and IFRS.

Accounting for Depreciation and Valuation of Inventory: i) Depreciation: Meaning of
Depreciation, Depletion, and Amortization; Causes, objectives, and methods of calculatinge
Depreciation; Changes in the method of computing Depreciation. ii) Inventory Valuation:
Meaning, significance, Inventory Record System- Periodic and Perpetual; ascertainment of
inventory-Lower of cost and Net Realizable Value (NRV) Rule.

Preparation of Financial Statements: Capital and revenue expenditures and receipts; Preparation
of financial statements of both profit seeking (Sole Proprietorship only) and non- profit secking
concerns, adjustments, Events occurring after the date of Balance Sheet,

Accounting for Partnership Firms: Mcaning, Lssential clements of Partnership, Partnership
Deed, Accounting for Admisston, Retirement, Death, Admission cum retirement of partners:
Changes in Profit-sharing ratios; Treatment of Goodwill and Joint Life Policies; Dissolution ol
partnership firm. 3

h

Special Types of Accounting: i) Hire Purchase: Concepts, Ordinary Sale vs. Sale on Hire
Purchase, Journal entries and ledger accounts in the books of Hire Vendors and IHire purchaser,
Calculation of miterest, partial and full repossession; profit computation under Stock and Debtors
System. 1) Consignment: Features, Accounting treatment in the books of the consignor and
consignee, treatment and valuation of normal and abnormal loss, ordinary commission and De!
credere Commission.

Suggested Readings:

«  M.C., Shukla, T.S. Grewal, & S.C.: Gupta, Advanced Accounts Vol -1, S. Chand & Co.: Now
eind.

e Lal, Jawahar, Seema Srivastava & Abrol, Shivani. Financial Accounting Text and Problems,
limalava Publishing IHouse, New Delhi.

¢« (oyal. Bhushan Kumar, and H. N. Tiwary, Financial Accounting, Taxmann

e« S. N Maheshwari & S. K., Maheshwari: Financial Accounting, Vikas Publishing House: New

Delhi. '

e . Schgal. Financial Accounting, Vikas Publishing House: New Delhi.

o P.C. Tulsian: Financial Accounting, Pearson Education: New Delhi,

o Compendium of Statements and Standards of Accounting. ICAl, New Delhi.

e



DSCC-2 (Major)
Business Management (COMM102C)

Introduction: Concept. objective and importance of Management, Managerial Functions—An
overview; Evolution of the Management Thought, Contributions of 'different schools of
management; Classical Approach: F.W. Taylor, Henry Fayol, Neo-Classical and Human
Relations Approaches: Elton Mayo, Merry Parker Follet. Hawthorne Experiments, Behavioral
Approach, Systems Approach, Contingency Approach, Scientific Management, MBO, MBE
*Fortune at the Bottom of the Pyramid’.

Planning and Organizing: i) Planning: Concept, nature, importance and types of planning,
planning process; Decision-making; Forecasting; Strategy Formulation. ii) Organizing: Basic
Concepts, objectives, importance, principles, and process of organizing; Different types of
organization structure- Line, Staff, Line and Staff; Formal and Informal Structure;
Divisionalization: Functional, Project, Matrix, and Network; Delegation and Decentralization of
Authority; Span of Management.

Motivation: Concept, Importance, and types of motivatiopn; Maslow’s Need Hierarchy Theory;
Three need theory of McClelland; Herzberg’s Two Factors Theory, McGregor’s X theory and Y

theory, Vroom’'s Expectancy Theory. Relationship between Maslow’s theory and lHerzberg's
theory; Motivation vs Morale.

Leadership: Meaning and Role of leadership; Different styles of Leadership; Qualities of a
successful Leader: Tannenbaum and Schmidt Behaviour model of leadership; Blake and
Mouton’s Managerial Grid; Fiedler’s Contingency Approach; Trait and Situational Theory of
[.eadership; Leadership vs. Management

Co-ordination and Controlling: i) Co-ordination: Concepts and importance, principles, and
techniques. ii) Controlling: Concept, features, importance, and Steps in controlling; Resistance to
control; Principles of Effective Control, Major Techniques of control. Relationship between
Planning and Controlling.

Suggested Readings:

e H. Koontz & H. Weihrich: Essentials of Management: An International and Leadership
Perspective, McGraw Hill Education: New Delhi.

e R.P. Stephen, P. Agrawal & M. Nanda: Fundamentals of Management - Essential Concepts and
Applications, Pearson: New Delhi.

e Griffin, R. W., Management Principles and Application. Cengage

e P.F. Drucker: The Practice of Management, New York: Harper & Row,

e 1. M. Prasad: Principles of Management, S. Chand & Sons: New Delhi.

e P.C. Tripathi: Principles of Management, McGraw Hill Publishing: New Delhi.

2iPage




DSE-1 (Minor)
Business Mathematics (COMM103E)

Introduction to Algebra: Indices - Positive indices - Fractional indices - Operation with power
functions; Logarithms — Definition, General laws of logarithms and its applications (Without
the application of antilog); Set theory - Representation of a set, Concept of Subset. Power sets
Size of a set: Set; operations-union, intersection, disjoint, set difference, compliment; Properties
of union and intersection of sets. associative properties, commutative properties, 1dentity
property of union, intersection property of the empty set, distributive properties.

Matrix Algebra & Determinants: Definition of Matrix, Different types of Matrix: Matrix
Operations — Equality, Addition, Subtraction and Multiplication. Transpose of matrices, Inverse
of a Matrix; Solution of linear simultaneous equations by matrix inversion method (having
unique solution and involving not more than three variables); Determinant of a square
Matrix (up to third order), Expansion of a determinant; Types of determinants’; Properties
of Determinants, Addition and Multiplication of determinants, Minor and cofactors of a
determinant, Solution of system of linear equations (up to third order) using Cramer’s Rule.

Linear Programming Problem: Formulation of linear programming problem (L.PP). Graphical
solution to LPP. Cases of unique and multiple optimal solutions. Unbounded solutions.
infeasibility, and redundant constraints. =

Calculus-I: Mathematical functions and their types — lincar, quadratic, polynomial: Concepts of
limit and continuity of a function; Concept of differentiation: Rules of differentiation — simple
standard forms. Applications of differentiation — clasticity of demand and supply; Maxima
and Minima of functions (involving second or third order derivatives) relating to cost,
revenue and profit. Partial Differentiation: Partial derivatives up to second order; Homogeneity
of functions and Euler’s theorem; Total differentials; Differentiation of implicit functions with
the help of total differentials.

Calculus-II: Integration- Standard forms. Methods of integration — by substitution, by parts,
and by use of partial fractions; definite integration; Finding areas in simple cases [Without
I'rigonometric application]

Suggested Readings:

* Alpha C. Chiang: An Introduction to Mathematical Economics. Prentice Hall Inc.

* N.D. Vohra: Business Mathematics and Statistics, McGraw Hill Education: New Delhi
* J K Singh: Business Mathematics, Himalaya Publishing House: New Delhi

* N K Nag: Business Mathematics, New Central Book A gency: Kolkata.
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Skill Enhancement Courses
Basics of Computer Application (SEC-1)

* Basic Computer Conce pt: Fundamentals of Computer, Input Output Device, Operating
Software

* Word Processing: Introduction to MS Word, Using the Insert Tab, Creating and
Handling Tables, Use of Templates, Creating Macros

* Spreadsheet Package: Introduction to MS Excel, Using the Insert Tab, Using the E’-anC
functions on the Formulas tab. Data Sorting and Filtering

* Presentation Package: Introduction to MS PowerPoint, Using the Insert Tab, Design
Tab, Presentation Tab and Animations, Creating a Slideshow

* Basics of Internet usage: WWW and Web ijwsérs, Protocols, Security and Threats
in Internet, Email

Suggested Readings:
e Firouz Mosharraf (2008): Basics of computer science Behrouy l‘orouzan, Firouz Mosharraf.
Cengage Learning, New Delhi
* Heather Goslin (2013): An Introduction to MS Office, CTI Education Group
 Allan F. Livers (2008): Using Microsoft Office to Enhance Student Leamning, SAGE
Publications

* Qusay F. Hassan (2018): Internet of Things A to Z Technologies and Applications, Willey |
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Introduction: Communication- Meaning, Types, Importance, Process, Different forms of

Communication Process, Channels of communication, Significance of Feedback, Corporate
Communication, Communication Networks, Barriers to Effective Communication, Ways to
overcome the Barriers.

\z

¥

Business Correspondence: Letter Writing, presentation, Inviting quotations, Scnding quotations.
Placing orders, Inviting tenders, Sales letters, claim & adjustment letters, Memorandum, Notices.
Agenda, Minutes, Job application letter, preparing the Resume., advertisements, official documents.
booklets, newspapers, instructional manuals and other documents.

Report Writing: Business reports, Types, Characteristics, Importance, Elements of structure.
Process of writing, Order of writing, the final draft and check lists for reports.

Vocabulary and Oral Presentation: Words ofien confused, Words often misspelt, common errors
in English. Power Point Presentation and Group Discussion.

Suggested Readings:

e Bovee, and Thill, Business Communication Today, Pearson Education.

 Lesikar, RV. & Flatley, M. E. Kathryn Rentz; Business Communication Making
Connections in Digital World, 11th ed., McGraw Hill Education.

* Shirley Taylor, Communication for Business, Pearson Education

e [ocker and Kaczmarek, Business Communication: Building Critical Skills, McGraw Hill
Publications.

* [Leena Sen, Communication Skills, PHI Learning
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Second Semester

DSCC-3 (Major)
Advanced Accounting (COMM201C)

"

Branch Accounts: Concept of Branch. Features, and objectives of Branch Accounting; Pricing
of goods sent by Head Office to Branch; Accounts for various types of branches- Synthetic
method, Analytical Method, and Final Accounts method.

Departmental accounts: Basic Concepts, features, and objectives: Departmental Accounting vs
Branch Accounting; Preparation of Departmental Final Accounts- Departmental ‘I'rading & P/L
A/C, General P/L A/C and Balance Sheet: Inter-departmental transfer of Goods/Services- at cost
price, at normal selling price, and at loaded price; Adjustment for unrealized profit.

[nsurance Claims: Meaning of Fire, Claim for Loss of stock, consequential loss or loss of profits,
computation of claim, Adjustment for abnormal stock (poor selling goods); Average Clause.

Insolvency Accounts: Basic Concepts, Act of Insolvency, Procedures of Insolvency, Preparation
of Statement of affairs, Deficiency account. % |

Royalty Accounts: Basic Concepts, Important Terminologies: Minimum rent, short workings, and
Its recoupment; Journal Entries and ledger Accounts in the books of Lessor and Lessee;
Adjustment of minimum rent and shortworkings in the event of strike and lock-out, sub-lease.

Investment accounts: Fundamentals as per AS-13, Classification of Investment. Investment in
Fixed-income, and Variable-income bearing securities; Preparation of Investment Account,
transaction with brokerage, STT. Ex-interest and Cum-interest, valuation of Investment under
FIFO, LIFO, and weighted average method.

Accounting for Business Acquisition: Business Acquisition before date of incorporation- concept
and consequences on Operating result: Rationale behind splitting of profits between Pre-
incorporation and Post-incorporation periods; Accounting treatment of Profits/Loss of Pre and Post
incorporation period.

Suggested Readings:

« M.C, Shukla, T.S. Grewal. & S.C.: Gupta, Advanced Accounts Vol.-I. S. Chand & Co.- New -
Delhi. |

 O.P.Jain & K.L. Narang: Advanced Accountancy, Kalyani Publishers, New Delhi.

* M. Hanif & A. Mukherjee: Financial Accounting, McGraw-Hill Publishing Co.: New Delhi.

* 5. N. Maheshwari & S. K., Maheshwari: Financial Accounting, Vikas Publishing House: New
Delhi,

* R.L. Gupta & Radheswami: Advanced A ccountancy, S. Chand: New Delhi.

* Schgal & Sehgal: Advanced Accountanc)y, Taxmann Publication.

* The study material issued by the Institute of Chartered Accountants of India, New Delhi.
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DSCC-4 (Major)
Marketing Management (COMM202C)

Introduction: Nature, scope, importance, and functions of marketing; Evolution of
marketing; Sclling wvs Marketing; Marketing mix, Marketing environment: concept,
importance, and components (Economic. Demographic, Technological. Natural, Socio- Cultural.

and Legal); Online Marketing; Impact of Global Marketing in India :

Consumer Behaviour; Nature and Importance, Patterns of Buying Behaviour: Consumers’
decision-making process; Factors influencing consumer buying behaviour,

Market segmentation: concept, importance. and rationale for segmentation; Bases for
Scgmentation; Market Targeting; Market Positioning; Niche Marketing; Product differentiation
vs. market segmentation.

Product and Pricing: i) Product: Concept and importance, Product classifications: Concept of
product mix; Product Portfolio- BCG Matrix: Branding, packaging, and labelling: Product-
Support Services; Product life-cycle: New Product Development Process; Consumer adoption
process. ii) Pricing: Meaning and Significance; Factors affecting price of a product; Pricing
policies and strategies. e

Distribution Channels and Physical Distribution: Channels of distribution - meaning and
importance; Types of distribution channels: Factors guiding choice of distribution channel:
Wholesaling and retailing; T'ypes of Retailers: c-tailing, Physical Distribution.

Promotion: Nature and importance of promotion: Types of promotion: advertising, personal
selling, public relations & sales promotion, and their distinctive characteristics; Promotion mix
and factors affecting promotion mix decisions: Promotion mix Strategies-Push and Pull
Strategies.

Suggested Readings:

* Kotler, Philip, Gary Armstrong, Prafulla Agnihotri and Ehsanul Haque: Principles
of Marketing. 13th edition. Pearson Education,

* Koller & Keller, Marketing Management, Pearson

* Ramaswami and Namakumari, Marketing Managemeni, McMilla

* Saxena, Marketing Management, McGraw Hill |

* Michael, J. Etzel, Bruce J. Walker, William J Stanton and Ajay Pandit: Marketing: Concepts
and Cases. (Special Indian Edition)., McGraw Hill Education

* William D. Perreault, and McCarthy, E. Jerome: Basic Marketing. Pearson Education.

* (. B Gupta: Marketing Management, Sultan Chand Publications, New Delhi

* [lacobucci and Kapoor: Marketing Management: A South Asian Perspective. Cengage
Learning.
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DSE-2 (Minor)
Microeconomics (COMMZ203E)

Introduction: Demand and Supply: Determinants of demand, movements vs. shift in demand
curve, Determinants of Supply, Movement along a supply curve vs. shift in supply curve; -
Market equilibrium and price determination. Elasticity of Demand and Supply. Application
of demand and supply.

Consumer Theory: Ordinal Utility Theory: (Indifference curve approach): Consumer’s
preferences; Interference curves: Budget line; Consumer’s equilibrium; Income and substitution
effect; Price consumption curve and the derivation of demand curve for a commodity; Income
Consumption Curve, Revealed Preference Theory

Theory of Production and Cost: Firm as an agent of production. Concepts of Production
function. Law of variable proportions; Isoquants; Return to scale. Economics and Diseconomies
of scale.  Costs in the short run. Costs in the long run,'Profit maximization and cost
minimization. Equilibrium of the firm, Technological Change: the very long run.

Market Structure Perfect Competition: Assumption; Theory of a firm under perfect
competition; Demand and Revenue; Equilibrium of the firm in the short run and long run,
The long run industry supply curve: increasing, decreasing and constant cost industry.
Allocation efficiency under perfect competition ”

Monopoly: Short-run and long-run equilibrium of monopoly firm; Concept of supply curve
under monopoly; Allocation inefficiency and dead-weight loss monopoly; Price discrimination.
Imperfect Competition: Difference between perfect competitions, monopoly and imperfect
competition; (1) Monopolistic Competition: Assumption; Short — run Equilibrium; Long run

Equilibrium; Concepts of excess capacity; Empirical relevance.

Suggested Readings:
 Pindyck, R.S., D. L. Rubinfeld and P. L. Mehta: Microeconomics, Pearson Education.
* N. Gregory Mankiw: Principles of Micro Economics, Cengage Learning
» Maddala G.S. & E. Miller: Microeconomics: Theory and Applications, McGraw-Hill Education.
e Paul A Samuelson & William D Nordhaus: Microeconomics, McGraw-Hill Education.
e Dipen Roy Managerial Microeconomics, Kunal Books., New Delhi
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Fundamentals of Accounting
(Interdisciplinary Course-}I)

Theoretical Framework: Meaning and Scope of Accounting, Accounting Concepts, Principles
and Conventions, Accounting Terminologies

Accounting Process: Basic Accounting Procedures - Journal Entries, Ledgers, Trial Balance

Cash Books: Simple Cash Book, Two-column Cash Book and Three-column Cash Book, Petty
Cash Book and the Imprest System of Petty Cash

Preparation of Final Accounts of Sole Proprictors: Final Accounts of Non-Manufacturing
Entities, Final Accounts of Manufacturing Entitics

Financial Statement Analysis: Comparative and Common Size: Ratio Analysis (Elementary
level problems). '
Suggested Readings:

o M.C,, Shukla, T.S. Grewal, & S.C.: Gupta, Advanced Accounts Vol.-I. S. Chand & Co.:

New Delhi. S8

e M. Hamf & A. Mukherjee: Financial Accounting, McGraw-Hill Publishing Co.: New
Delhi.

* 5. N. Maheshwari & S. K., Maheshwari: Financial Accounting, Vikas Publishing House:
New Delhi.

* D.Sehgal : Financial Accounting, Vikas Publishing House: New Delhi.

e P.C. Tulsian: Financial Accounting, Pearson Education: New Delhi. |

» Compendium of Statements and Standards of Accounting. The Institute of Chartered
Accountants of India, New Delhi
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Skill Enhancement Course
Financial Accounting using Spreadsheet (SEC-2)

Features of Excel: Introduction to Financial Modeling; Basic and Advanced Features of Excel.
Fmancial Functions in Excel.

EXCEL IN ACCOUNTING: Financial Statement Preparation; Common Size Statements From
I'rial Balance in Excel . Preparing Profit & Loss Statement with Pivot Tables and Preparing
Balance Sheet with Pivot Tables; Bank Reconcilliation Statement Using Spreadsheet.
Depreciation; Revising the Accounting concept of deprecation. Straight I.inc Method(SILN)
Declining Balance Method (DBM), Double Declining Balzin-::c([)i)B), Sum of Years Digits
Method(SYD), Multiple Asset Account using spreadsheet. Homework: Practice of Depreciation

with Excel formulas.

e |

FINANCIAL ANALYSIS : Capital Budgeting; Selection of project, Net present value (NPV),
Internal rate of return (IRR); Breakeven Analysis and Sensitive Analysis. Cash Flow Analysis
using Spreadsheet. Ratio Analysis Using Spreadsheet Cés’lh-\/clume--Pro_ﬁt-Analysis. Graphical
representation of data. i

CREATING BUSINESS SPREADSHEET: Data Filtering and Sorting; Pivot Tables; Creating
a spreadsheet in the area; Loan and Lease Account, Payroll Accounting Structure, | Frequency
distribution and its statistical parameters.

Suggested Readings:

* . Sudalaimuthu and S. Anthony Raj (2008): Computer applications in business : including
introduction to  information technology, MS Office, HTMIL. and Tally, Himalaya
Publishing House,, New Delhi

* R Parameshwaran (2004): Computer applications in business, S.Chand & Company, New
Delhi |

* Sushila Madan: Computer Applications in Business, Scholar Tech Press, New Delhi.

* Sushil Mathur & Pooja Jain: Computer Applications in Business, Galghatia Publishing
Company.
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